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Ziele der zweiten Aufgabe

Sie haben bei der ersten Aufgabe lhren Wohnort in Kassel und lhren Weg zur Uni eingezeichnet,
sowie mit Hilfe des Feldrechners die Lange des Weges ermittelt und in die Attributtabelle
eingetragen. Zusatzlich trugen Sie Ihren Studiengang und lhre Verkehrsmittelwahl als Sachdaten ein.
Ich habe die von lhnen gelieferten Daten zusammen mit den Punktdaten der letzten 6 Jahre so
zusammengestellt, dass Sie nach verschiedenen Fragestellungen ausgewertet werden kdnnen.
Wenn Sie Aufgabe 2 bearbeitet haben, kdnnen Sie folgende Fragen beantworten:

x  Wie weit sind die Kursteilnehmer/innen durchschnittlich zur Uni unterwegs?

x  Mit welchen Verkehrsmitteln sind die meisten Teilnehmer/innen unterwegs?

x  Wie beeinflusst die Entfernung zur Uni die Verkehrsmittelwahl?

x In welchen Stadtteilen leben besonders viele und besonders wenige Kursteilnehmetr/innen?

Dabei lernen Sie verschiedene GIS-Techniken zur Aufbereitung, Analyse und Visualisierung von
Geodaten kennen:

x Auswahlabfragen nach Afttributen.

Attributwerte mit Hilfe des Feldrechners auf andere Spalten (libertragen.
Statistische Werte fiir einzelne Attributspalten ermitteln.

Réaumliche Attributiibertragung von einem Punktlayer auf einen Polygonlayer.
Zéhlen von Punkten in Polygonen.

Kategorisierte und abgestufte Klassifikation von Vektorlayern.

Erstellung von Karten zur Kerndichte (Heatmaps)

X X X X X X X

Visualisierung von Werten in Tortendiagrammen.
x  Erstellung eines Kartenlayouts.

Sie arbeiten bei dieser Ubung mit dem Punkt-Shapefile, welches ich aus lhren Daten und den Daten
der letzten Semester erzeugt habe, sowie mit einem Polygon-Shapefile, welches die Grenzen der
Stadtteile Kassels enthalt. Am Ende erstellen Sie zwei Karten, welche die Inhalte so visualisieren,
wie die Beispiele auf Seite 2 zeigen sowie weitere Karten zur Kerndichte. Aulerdem tragen Sie
verschiedene statistische Analyseeregebnisse in eine Tabelle ein.

Vorbereitung

Inhalt der Ordner

x Laden Sie auf der Moodle-Seite des Kurses die Geodaten zur zweiten Aufgabe herunter und
entpacken Sie das Zip-Archiv daten_aufgabe_2.zip an einem Ort lhrer Wahl.

x Im Verzeichnis daten_aufgabe 2 finden Sie folgende Unterordner:
1_meine_Daten (hier kdnnen Sie Ihre Daten speichern)
auswertungstabelle (hier finden Sie die Tabellen, um Ihre Ergebnisse einzutragen)
(

orientierung hier finden Sie das StralRen- und das Tram-Netz zur Orientierung)
ortsteile (Hier finden Sie den Layer mit den Ortsteilgrenzen)

unipunkt (Hier finden Sie den Standort der Uni)

wohnorte (Hier finden Sie den Punktlayer mit den Wohnorten, Entfernungen und

der Verkehrsmittelwahl)
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Laden der Ebenen

X

Laden Sie den Vektorlayer stadtteilbasiskarte.shp aus dem Ordner ortsteile

(Menutaufruf: LAYER > VEKTORLAYER HINZUFUGEN)

Achten Sie darauf, dass im AusklappmenU >Dateien pes Typs< Esri-Shapefile ausgewahlt und
fur die ZeicHen-Kobierung utf 8 vorgesehen ist!

Da fir den Stadtteil-Layer eine Darstellungsvorschrift in Form der Datei
stadftteilbasiskarte.qml vorhanden ist (siehe Folienskript S. 37 - 39), wird die Ebene in einer
festgelegten Darstellung (graue Grenzen, wei3e Flachen und hellgraue Beschriftung)
geladen.

Weisen Sie anschlieRend dem Projekt das Koordinatenbezugssystem (KBS) des Layers zu:
LAYER > LAYERKBS pEm ProJexT zuweisen. Samtliche Daten liegen im KBS DHDN-Gaul® Kriger
Zone 3 (EPSG:31467) vor.

Als ProuexTTiTEL tragen unter EINSTELLUNGEN > PROJEKTEINSTELLUNGEN im Bereich ,ALLGEMEIN®
Aufgabe 2 ein. Die PrapE sollten Sie ,relativ speichern, dann kénnen Sie die Aufgabe
zwischen verschiedenen Rechnern hin und her tragen! (PRoJEKT > PROJEKTEINSTELLUNGEN)

Speichern Sie das Projekt (Datel > ProJexT sPeICHERN) als Aufgabe 2.qgs im Ordner
1_meine_daten.

Vergessen Sie nicht im Laufe der weiteren Bearbeitung regelmaRig zu sichern!
Laden Sie aus dem Ordner wohnorte den VEKTORLAYER ALLE_WAHREN_WOHNORTE.SHP

Sie sehen in der Kartenansicht den Punktlayer mit den Wohnorten, ohne dass Informationen
aus der ArtriBuTTABELLE dargestellt werden. Neu geladene VEkToRLAYER werden immer
Lunklassifiziert mit einer einheitlichen und zufélligen Farbe dargestellt, wenn keine
Darstellungsvorschriftt in Form einer gleichnamigen QML-Datei vorliegt.

Mit den verschiedenen im Menu ,AnsicHT® angebotenen Funktionen kdnnen Sie den
Kartenausschnitt verschieben, auf die voLLE AuspeEHNUNG ALLER LAYER oder eines LAYERS ZOOMEN
bzw. mit den Werkzeugen Hineinzoomen und Hinauszoomen den angezeigten Kartenausschnitt
verandern. Nutzen Sie diese Werkzeuge, um einen Kartenausschnitt mit allen Punkten
anzuzeigen.

Sie kénnen, wenn Sie wollen, aus dem Ordner Orientierung das Stral3en- und das Tram-Netz
hinzuladen, um sich besser orientieren zu kénnen. Die beiden Layer werden jedoch fir die
weiteren Analysen nicht bendtigt.

Die Wohnorte nach Verkehrsmittelwahl kategorisieren

Wenn Sie den Wohnorte-Layer im Inhaltsverzeichnis mit einem Mausklick aktiv gesetzt haben,
kdnnen Sie uUber Laver > ArTrRiBUTTABELLE einen Blick in die Sachdatentabelle werfen. Die einzelnen
Attributspalten haben folgende Bedeutung:

X
X
X
X
X

zeile = Laufende Zeilennummer

stud = Studiengang: (siehe Aufgabe 1)

verk = Verkehrsmittelwahl (siehe weiter unten)

entf= Die Entfernung zur Uni in Metern (auf der Stral’e gemessen)
Jahr = Jahr der Datenerfassung

Verandern Sie die Darstellung des Punktlayers alle_wahren_wohnorte.shp so, dass die
Verkehrsmittelwahl der Studierenden in der Kartenansicht sichtbar wird. Sie missen den Layer nach
den AttriBuTWERTEN des Feldes ,verk” klassifizieren. Da fir dieses AttrisuT nur 4 verschiedene Werte
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(A = Auto, F = zu FuB3, R = Fahrrad und O = OPNV) vergeben worden sind, ist es nicht notwendig
Klassen zu bilden. Vier verschiedene Kategorien lassen sich gut in einer Karte darstellen. Sie wahlen
deshalb den StiL ,Kategorisiert*.

x Gehen Sie Uber Laver > EicenscHAFTEN in den Eigenschaften-Dialog des Layers
alle_wahren_wohnorte und wahlen den Bereich SriL.

x Wahlen Sie im Ausklappmen links-oben ,kateGorisierT”, um die Wohnorte nach dem
gewahlten Verkehrsmittel zu klassifizieren.

Im Ausklappmen SpaLte wahlen Sie die darzustellende Attributspalte, also verk aus.

x Klicken Sie auf die Schaltflache KLassiFiziErReN.

Jeder Attributwert wird jetzt in einer unterschiedlichen Farbe dargestellt. Es ist auch eine
Klasse fir nicht attributierte Objekt vergeben worden, die Sie jedoch sogleich I6schen
kénnen: Klicken Sie auf die Klasse ohne Buchstabe und driicken Sie auf die Schaltflache
»LOSCHEN®.

x AnschlieRend kénnen Sie die Grofde, Farbe, Umrandung oder auch das Punktsymbol fir jede
Klasse individuell einstellen und eine Beschriftung fur die Werte hinzufligen (Auto, Fahrrad
etc.)

x Nach dem Klassifzieren gelangen Sie mit einem Doppelklick auf das jeweilige Symbol in den
Dialog zur Symbolauswahl. Dort klicken Sie links auf Marker > EiINFAcHE MARKIERUNG und
andern den rechts den UmranbuncssTIL (ber das Ausklappmenti zu eiNn STIFT®. So erhalten Sie
Punkte ohne Umrandungslinie. AnschlieRend beschriften Sie die Kategorien unter
,BESCHRIFTUNG"

L symbciauswant Ay

A\ Allgemein i Kategorisiert 7 Symbollayertyp Einfache Markierung -
Stil

‘:: B;SChriﬁungen Spalte | verk - | Farben Falung (| Rahmen (S

= Felder Symbol B W//y s Grofie 1,00000 2 Millimeter

Anzeigen Umrandungsstil Kein Stift

9’:“0 Aktionen Symbol |W B+ Marker Umrandungsstarke 0,00 2 Millimeter
< Verkndgfungen e A....Autg -« Einfache Markienung Winkel 0.00°
* | Diagramme E E?:hprf\jd K Y- Versatz 000000 15 (000000 5 [Millmeter
h'd Metadaten . R Rad Ankerpunkt HZentriert - VMitte
Datendefinierte Eigenschaften .
Klassifizieren | | Hinzufiigen Laschen Alle laschen
@ICO+XAAAXT | >
W Layerdarstellung b
Abb. 3: Stil "Kategorisiert" Abb. 4: Symboleigenschaften

Wenn Sie mit der Darstellung zufrieden sind, gehen Sie folgendermal3en vor:

X

X

Klicken Sie auf die Schaltflache ,ALs VorGaBE sPEICHERN - Sie erzeugen eine Stildatei mit dem
gleichen Namen wie das Shapefile, also ALLE_ waHREN_woHNORTE.aML. Sie kdnnen jederzeit Uber
die Schaltflache , StiLvorcaBEN wiEDERHERSTELLEN® zU dieser Darstellung zurtickkehren.

Wechseln Sie zum Reiter ,ALLcevEN® und andern den Anzeigennamen zu
,Verkehrsmittelwahl der Erstsemester* \Verlassen Sie den EicenscHarFTEN-DiaLoc mit O.K

Zoomen Sie so in die Ansicht, dass nur der Bereich Kassels angezeigt wird, in welchem
Punktdaten liegen.

Laden Sie die Vektor-Punktdatei uni-punkt.shp aus dem Ordner uni_punkt und stellen Sie den
Punkt mit einem auffalligen Symbol dar (Nutzen Sie den EicenscHAFTEN-DiALOG).

Speichern Sie lhr Projekt mit dem Menuaufruf,ProJekT > PROJEKT SPEICHERN®

Nun sollten Sie ein Kartenbild sehen, dass in etwa so aussieht:
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Abb. 5: Wohnorte klassifiziert nach Verkehrsmittelwahl

Auswertung der Wegstrecke unter Beriicksichtigung des Verkehrsmittels

Nach dem Sie den Wohnort-Layer nach der Verkehrsmittelwahl klassifiziert haben, kdnnen Sie allein
aus der Betrachtung des Kartenbildes einige Sachverhalte erkennen. Die Studierenden leben
schwerpunktmaRig in bestimmten Stadtteilen und kommen innerhalb eines bestimmten
Entfernungsradius meist zu Fuld und ansonsten mit 6ffentlichen Verkehrsmitteln zur Uni. Auto- und
Radfahrer sind eine Minderheit. In einem weiteren Schritt sollen Sie den Layer mit dem Werkzeug
»,GrRouPSTATS® @analysieren, um herauszufinden, welche Strecke die Studierenden unter
Berucksichtigung der Verkehrsmittelwahl im Mittel zur Uni zurticklegen.

Uberpriifen Sie, ob das Werkzeug Vektor > Group Stats > Group StaTs installiert ist.

Wenn nicht: Installieren Sie das Werkzeug tber den MenlUaufruf: ERWEITERUNGEN > ERWEITERUNGEN
VERWALTUNG UND INSTALLIEREN. Sie finden die Erweiterung, wenn Sie in die Suchen-Zeile Group eintragen.

Auswerten der Entfernungen und Eintragen in die Tabelle

Sie sollen analysieren und visualisieren, wie die Entfernung zur Uni die Verkehrsmittelwahl der
Kursteilnehmer/innen beeinflusst und wie sich die Verkehrsmittelwahl in den verschiedenen
Stadtteilen unterscheidet.

Offnen Sie eine der Flachenbilanzen-Tabelle aus dem Ordner AuswerTungsTageLLE. Wenn Sie die
beiden Tabellen ausfillen, entstehen verschiedene Kreis- und Sdulendigramme, die Sie spater ins
Druck-Layout einfiigen sollen. Um die Inhalte zu ermitteln 6ffnen, Sie mit dem Menuaufruf

VEekTOR > GRroup STats > GRrour S1aTs das Gruppenstatistik-Werkzeug. Mit diesem Werkzeug kénnen
Sie Attributspalten nach statistischen Parametern wie Summe, Durchschnitt oder Maximum
analysieren.
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Die Benutzeroberflache des Werkzeugs besteht aus mehreren Fenstern. Im grof3en Fenster wird das
Ergebnis lhrer statistischen Abfrage als Tabelle visualisiert. Im Fenster ,FieLos® finden Sie die
Attributspalten, des mit dem Lavers-AuskLapPMENU ausgewahlten Layers (Nummerische Spalten werden
mit Kreisdiagramm symbolisiert) sowie die verschiedenen statistischen Funktionen. Mit der Maus
kénnen Sie AttriBuTsPALTEN Und FunkTionEN in die kleineren Fenster ziehen:

x Wahlen Sie oben unter ,Lavers* den Punktlayer mit den Wohnorten ~ |S=rmssssns=s .
(Verkehrsmittelwahl der Erstsemester) €
x Das Fenster Rows definiert die Zeilen der zu erstellenden -
Auswertung. Ziehen Sie mit der Maus den Eintrag ,verk® aus dem P
Fenster FieLbs nach Rows. r Py
Jetzt haben Sie definiert, dass in den Reihen die Verkehrsmittelwahl ZE! nedan
angezeigt wird. il st . 5
x Das Fenster VaLue definiert den Wert, der statistisch ausgewertet o
werden soll: Ziehen Sie mit der Maus den Eintrag ,entf* (die ol oo
Entfernung) in dieses Fenster. ot
x Das Fenster CoLumns definiert die statistischen Parameter, die in den o= Velve (] e NULL values
Spalten abgebildet werden: Wir benétigen: Weiteste Strecke (max), = o
Mittlere Entfernung (averace), kiirzeste Strecke (miN) und Anzahl
(counT): Ziehen Sie diese Eintrage in das Fenster coLumns. o
x Jetzt kénnen Sie Uber CaLcuLaTe lhre Werte anzeigen lassen e

Die im linken Fenster angezeigte Tabelle zeigt die Werte, die Sie in die Abb. 6: Group-Stat Fenster
Tabelle 1 der Flachenbilanzen-Datei eintragen missen. Tragen Sie die Werte (ohne Komma) in
Tabelle 1 ein. AnschlieRend wird das Ergebnis als Balken- und Kreisdiagramm visualisiert.

Wenn Sie verk mit der Maus wieder zurlick in Fields schieben, kdnnen Sie anschlie3end Uber
caLcuLaTe die Entfernungswerte fur samtliche Verkehrsteilnehmer ermitteln.

Um Tabelle 2 auszufullen, mussen Sie lhre statistische Abfrage jeweils nach
Entfernungen filtern. Dazu verwenden Sie die Schaltflache FiLter im Ty
Werkzeug GrourSTat. Léschen Sie zunachst iiber cLear die Abfrage e -

Mit der Schaltflache FiLter kommen Sie in einen SQL-ABGRAGEEDITOR, Mit dem E i
Sie lhre Abfrage auf bestimmte Wertebereiche einschranken kénnen:

x  Mit "entf" <= 1000 schranken Sie die Verkehrsteilnehmer auf den ot
Bereich bis 1000 m Entfernung ein. In GrouprStats kdnnen Sie dann meden ‘
die Anzahl der Studierenden bezogen auf das Verkehrsmittel im s
Entfernungsbereich ermitteln. el

“entf” <= 1000 alll count

x Mit "entf" > 1000 AND "entf" <= 1500 decken Sie den nachsten
Wertebereich ab.

Gehen Sie entsprechend vor, bis Sie samtliche fiinf Zeilen von Tabelle 2 (C——
ausgefullt haben. Speichern Sie die fertigen Diagramme flr eine Verwendung
im Karten-Layout als Bilddateien (Rechte Maustaste: ,,ALs BiLD EXPORTIEREN".

Use only selected features Clear

Calaulate

Abb. 7: Group-Stat-Filterung
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Visualisierung der Ergebnisse auf Ebene der Stadtteile

Als nachstes ist es lhre Aufgabe, die Verteilung der Studierenden auf die Stadtteile zu visualisieren
und zusatzliche die stadtteilbezogene Verkehrsmittelwahl darzustellen. Dieses Ziel lasst sich
erreichen, wenn die Stadtteile nach der Anzahl der dort wohnenden Kursteilnehmer eingefarbt
werden (in quantitative Klassen) und gleichzeitig fur jeden Stadtteil ein Kreisdiagramm erstellt wird,
welches den Anteil der im Stadtteil genutzten Verkehrsmittel visualisiert. Zu diesem Zweck mussen
Sie die Attributwerte aus dem Punktlayer (Strecke + Verkehrsmittelwahl) auf den Polygonlayer mit
den Stadtteilen Ubertragen. Dabei soll QGIS die Anzahl der Studierenden in den Stadtteilen
insgesamt sowie nach Verkehrsmittelwahl summieren.

Dieses Ziel erreicht man Uber die das Werkzeug RAumLICHE ATTRIBUTUBERTRAGUNG (SpPaTiAL-JoIN). QGIS
fugt die Attributspalten des Punktlayers (Wohnorte mit Verkehrsmittelwahl) an den Polygonlayer
(Stadftteile) an und summiert die Attributwerte der Punkte fiir die einzelnen Stadtteile. Zusatzlich
werden alle Punkte in den Polygonen gezahlt. Um auch die Anzahl der jeweiligen Verkehrs-
mittelnutzer je Stadtteil summieren zu kdnnen, mussen Sie vorher aus der Attributspalte verk vier
neue Attributspalten fUr die vier Verkehrsmittel (Au, Fu, Oe, Ra) generieren, in denen es als Werte
nur 1 fiir ja und 0 fiir nein gibt, so dass sich aus der Summierung dieser Werte die Anzahl der
jeweiligen Nutzer der einzelnen Verkehrsmittel in den Stadtteilen ergibt.

Attriibutspalten fiir die Summierung der Verkehrsmittelwahl anlegen

Der QGIS-AusbrucksepiTer ist ein zentrales Werkzeug zur Analyse und Bearbeitung der Attributdaten
(der Tabelle) und kombiniert AsrraceepiTor und FELDRECHNER. Sie kdnnen mit diesem Werkzeug , WENN-
DANN-BEDINGUNGEN® definieren. Dazu gibt es die Feldrechnerfunktion CASE, mit der Sie eine neue
Attributspalte mit Werten flllen, die sich aus definierten Bedingungen ergeben. Um die Spalte Fu
anzulegen, in der sich flr jeden FuRganger der Wert 1 finden soll, gehen Sie folgendermalen vor:

X

Offnen Sie die ArTriBUTTABELLE UNd schalten Sie
den Laver Uber den gelben Stift bearbeitbar.

Offnen Sie den Feldrechner (Schaltflache ——
oben-rechts mit dem Abacus-Symbol) ==
Sie legen ein neues Feld (Fu) an: AUSGABEFELDTYP
Dezimalzahl, AuscasereLpereite 10.

Klappen Sie die Funktionsgruppe FELDER UND
WEerTE auf und lassen Sie sich mit ei

Rechtsklick auf verk die Werte der Spal
(Verkehrsmittelwahl) anzeigen.

Tragen Sie nun folgenden Ausdruck in den
Feldrechner ein (Feldnamen und Wert mit
Doppelklick abgreifen):

Case

When "verk" = 'F' then "1"

End

Erlauterung: Mit Case und End markieren Sie
Anfang und Ende der Bedingung.

When "verk" = "F" definiert die Abfragebedingung
— Es werden nur Werte eingetragen, wenn in der
Spalte verk der Wert F steht.

(4 Feldrechner 2] x|

[ rur 0 zusgewshite Objekte aktualisieren

Viorhandenes Feld erneuern -

X Meues Feld anlegen

Ausgabefeldname | Fu
Ausgabefeldtyp Dezimalzahl (real) -

Ausgabefeldbreite | 10 : Genauigkeit |0 :

Funktionsliste

Hilfe zur gewahlten Funktion ———————————

Klicken Sie den Feldnamen doppelt um ihn dem

Auvsdruck hinzuzufigen.
Per Rechtsklick auf den Feldnamen kinnen Sie

B Operatoren

ein Kontextmend mit Optionen zum Laden von
Beispielwerten dffnen.

Feldwerte

[ Expressions + A

F
- Felder und Werte ‘o'
i bezele R

fun &ins
B Letztes (fieldcalc)

Werte laden | Alle eindeutigen | | 10 Stichproben

¥ Operatoren

=l i e s Jln e Jlo
Ausdruck

Case [a]
When “verk™ = 7 then 1
End

Abb. 8: Werte eintragen iliber Bedingungen

then "1" bestimmt, dass wenn diese Bedingung zutrifft, der Wert 1 in die neue Saplte

eingetragen wird.
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Diesen Vorgang mussen Sie fur die vier Verkehrsmittel durchfiihren, bis lhre Attributtabelle in etwa
folgendermafen aussieht wie in Abb. 9. Denken Sie daran, anschliel’end den Bearbeitungsmodus
umzuschalten und dabei zu speichern.

AR AR EEEE R REE
zeile stud verk entf Jahr eins Fu Au Qe Ra

327 328.0| VULL o] 2934.0 2013.0 1 Q LL LL 1 LL
111 112.0|A o] 3265.0 2009.0 1 VULL VULL 1 VULL
113 114.0 A F 314.0 2009.0 1 1 LL LL LL
116 1M7.0A o] 2957.0 2009.0 1 VULL VULL 1 VULL
121 122.0| A F 1409.0 2009.0 1 1 LL LL LL
4acC 126 0(4A fa) 7238 0 2004 0 1 L 1

L Alle Objekte anzeigen .l [_?

Abb. 9: Attributtabelle mit den Spalten zur Verkehrsmittelwahl Au, Fu, Oe, Ra

Raumliche Attributlibertragung auf die Stadtteile mit Summierung der Werte

Jetzt kdnnen Sie die Attribute nach raumlichen Kriterien summiert auf die Stadtteile Gbertragen. Nach
diesem Prozess werden in der Tabelle des neuen StapTTEILLAYERS fUr jeden Stadtteil sowohl die Anzahl
der Studierenden insgesamt als auch die Anzahl der Studierenden, aufgeschlisselt nach der
Verkehrsmittelwahl verzeichnet sein.

x  Mit dem Menulaufruf: Vektor > DATENMANAGEMENTWERKZEUGE > ATTRIBUTE NACH PosiTion
zusAMMENFUHREN erreichen Sie das Dialogfeld zur rdumlichen Attributibertragung.

x  ZIELVEKTORLAYER ist der Layer, auf den Sie die Attribute Zimhm
ubertragen wollen, also die Stadtteil_basiskarte. Stadtsil_basiskarte .
. . Aus Vektorlayer
x Die Daten kommen aus dem Punktlayer mit den et dor Baloemesar .
Wohnorten, den Sie bisher bearbeitet haben e
H Attribute des ersten bestimmten Objekts verwenden
(Verkehrsmlttelwahl der ErStsemeSter) e Zusammenfassung der schneidenden Objekte erstellen
x  Sie wollen die ArtriBuTwERTE (Anzahl, Anzahl der Durchschnit || Min [ Max ( Summe (] Mitte
Verkehrsmittelnutzer etc.) aus dem Punktlayer e
beZOgen auf dle Stadtte”e Zusammenfassen - und I2_termml’aufgabe_El’cIaas_dateanU14§Iadﬂelle_mn_werlen.shp Durchsuchen
Zwar SsUMMIEREN. Ausgabetabelle
. . . . Nur passende Datensatze erhalten
X Fur d|e AUSGABESHAPEDATE| Wahlen S|e den Namen # Alle Datensatze erhalten (einschliellich nicht zutreffender Zieldatensatzen)
,Stadtteile_mit_werten ) o l o 1 Tsoione
x Bitte tragen Sie den Namen nicht in die Zeile ein, Abb. 10: Attribute iibertragen

sondern wahlen Sie mit der Schaltfléche ,DurcHsUCHEN®
einen sinnvollen Speicherort und geben Sie dort den Namen an.

x Starten Sie den Prozess mit O.K. Wenn der neue Layer in die Ansicht geladen worden ist,
kénnen Sie das Dialogfenster schlielRen.

Wahlen Sie den neuen Layer im Inhaltsverzeichnis mit der Maus aus und 6ffnen Sie Uber

VEKTOR > TABELMANAGER > TABELMANAGER den Tablemanager und I6schen Sie folgende Spalten, die Sie
nicht mehr bendtigen: xcoor, xcoor, dreh, fett, SUMzeile, SUMjahr, SUMeins. Sie kdnnen die Felder
mit Maus und gedriickter STRG-Taste auswahlen und Uber die Schaltflache DeLeTe I6schen.
AnschlieRend speichern Sie das Ergebnis iber die Schaltflache Save

Danach sollte die Attributtabelle in etwa so aussehen, wie in Abb. 11.

In der Spalte ,Count® ist die Anzahl der Punkte (Wohnorte der Studierenden) summiert, die sich im
jeweiligen Stadtteil befinden. In den Spalten SUM* ist die Anzahl der Studierenden je Stadtteil
vermerkt, die ein bestimmtes Verkehrsmittel verwenden. Die vielen Nachkommastellen sehen doof
aus, storen uns aber nicht weiter.
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IEHEH.IE]II SREEE i
ORTSBEZIRK ID_TEXT SUMentf SUMFu SUMAuU SUMDe SUMRa COUNT
0 |Mitte 01 46425.20000...| 13.00000000...| 0.000000000...| 15.00000000... 3.000000000...| 31.00000000...
1 |Sued 02 50434.00000...( 1.000000000...| 0.000000000...| 12.00000000...| 4.000000000...  17.00000000...
2 |West 03 114546.0000...| 0.000000000...| 0.000000000...| 33.00000000...| 2.000000000...| 35.00000000...
3 |Wehlheiden 04 97236.00000... | 0.000000000...| 0.000000000...| 24.00000000...| 2.000000000... 26.00000000...
4 |Wilhelmshoehe/ |05 68661.00000... | 0.000000000...| 1.000000000...| 9.000000000...| 2.000000000...| 12.00000000...
5 |Brasselsberg 06 9668.000000... | 0.000000000...| 0.000000000...| 1.000000000...| 0.000000000...  1.000000000...
B |Suesterfeld/ 07 7771.000000...( 0.000000000...| 0.000000000...| 1.000000000...| 0.000000000...  1.000000000...

Abb. 11: Tabelle des Stadtteillayers nach Attributiibertragung und Summierung

Klassifizierung des neuen Layers

Mir dem neuen Layer kdnnen Sie die Stadtteile nach der Anzahl der dort wohnenden Studierenden
klassifizieren und das Ergebnis visualisieren. Wenn Sie den Layer katecorisierT darstellen, ist die
Anzahl der Kategorien so hoch, wie die Anzahl der Stadtteile, weil ja in keinem Stadtteil die gleiche
Anzahl Studierende wohnt.! Versuchen Sie es einmal: (LAYER > EIGENSCHAFTEN > STIL > KATEGORISIERT>
KrassiFikationswerT: CounT). Insgesamt ergeben sich bei einer Kategorisierung mehr als 10 Kategorien.
Das ist fUr eine gute Darstellung zu viel. In diesem Fall ist eine Klassifikation Uber den Stil ,ABcEsTUFT"
sinnvoll.

Regelmaliges Speichern nicht vergessen!

AscesTurT bedeutet ,Zusammenfassung von Zahlenwerten in Klassen nach statistischen Kriterien®.
Es stehen funf Modi zur Auswahl:

1. Gleiches Intervall: Jede Klasse umfasst einen Wertebereich gleicher Grole.

2. Quantile: Jede Klasse beinhaltet die gleiche Anzahl von Objekten.

3. Jenks (natiirliche Briiche): ,Natiirliche Briiche” bedeutet, dass die Unterschiede innerhalb
einer Klasse mdglichst klein und die Unterschiede zwischen den Klassen moglichst grof? sein
sollen. QGIS versucht die Klassengrenzen an natirlichen Datenliicken zu orientieren.
Sinnvoll insbesondere bei einer ungleichmafligen Werteverteilung.

4. Standardabweichung: Klassenbildung nach Abweichung vom Mittelwert

5. Schéne Unterbrechungen: Durch 5 teilbare Klassengrenzen

Je nach Werteverteilung kann ein anderer Modus :ah’:"““‘“zoum = :
sinnvoll sein, um eine aussagekraftige Darstellung zu S:m,m, — e
bekommen. Bei der zu erwartenden ungleichmafigen | cesye | sl v nerieren  Modus | Natiriche Unterbrechunge
Werteverteilung sollten Sie den Modus ,natiirliche [mool * [wer___|Besctriturg
Unterbrechungen® nutzen. 40000120 512
12.0000-26... 12-26
x  Entfernen oder deaktivieren Sie samtliche I PR T
Layer aul3er stadtteile_mit_werten, —
Verkehrsmittelwahl der Erstsemester sowie - Lyordaseting
uni-punkt und gehen Sie in den — o
EicenscHAFTENDIALOG des Layers Layormischmod Hormal * Objokimischmod Hormal
stadtteile_mit_werten. Stil laden... Als Vorgabe speichem | Stivorgaben wiederherstell Stil speic
x Wahlen Sie den Bereich ,STiL“ und dann im Abirechen) |meenden
Ausklappmenti links-oben den Stil ,AsgesTuFT* Abb. 12: Stil abgestuft / Modus Jenks

x Die zu klassifizierende SpaLte mit der Anzahl der in den Stadtvierteln wohnenden
Studierenden hei3t COUNT (Hier ist die Anzahl der Punkte im Stadtteil summiert worden)

Die Anzahl der KLasseN sollte Ubersichtlich bleiben. 5 oder 6 Klassen ist eine gute Wahl.
x  Als Mopus wahlen Sie NATURLICHE UNTERBRECHUNGEN (JENKS).
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x Wenn Sie auf das Ausklappmeni ,FarsverLaur® klicken, haben Sie die Mdglichkeit einen
neuen FarsVERLAUF (GRADIENTE) zu erstellen. Erstellen Sie einen Graustufen-Farbverlauf, weil
eine farbige Darstellung der Flachen, zusammen mit den farbigen Punktdaten, bzw. den
spater zu erstellenden farbigen Diagrammen, keine gute Darstellung ergibt.

x Es ist optisch ansprechender, wenn die Grenzen der Stadtteile nicht mehr oder nur als diinne
Linien erscheinen. Sie kdnnen dies vor der eigentlichen KiassiFikation festlegen, in dem Sie mit
einem Klick auf die Schaltflache neben ,SymsoL* (,Anpern®) in den Dialog zum Bearbeiten des
Basis-Symbols gelangen. Dort kdnnen Sie den RanbsTiL zu keiN STIFT® dndern oder eine diinne
rétliche Linie wahlen und mit zweimal O.K. zurlck in den Klassifkationsdialog gehen.

x Sind samtliche Anderungen durchgeflhrt, klicken Sie auf die Schaltflache ,KLassIFIZIEREN.
Anschlielend konnen Sie die BescHrIFTunG der Klassen bearbeiten, um keine Kommazahlen in
die Legende zu bekommen — zum Schluss den Dialog mit O.K. verlassen.

Schauen Sie, ob Sie mit dem Ergebnis zufrieden sind und bearbeiten Sie gegebenenfalls nach!
Legen Sie anschlieliend den klassifizierten Punktdatenlayer Uber den klassifizierten Stadtteillayer
und achten Sie darauf, dass die Inhalte beider Ebenen farblich lesbar sind!

Kreisdiagramme, zur Darstellung der Verkehrsmittelnutzung in den Stadtteilen

Bevor Sie die Karte fertig stellen, ist die Verkehrsmittelwahl der Studierenden in den Stadtteilen mit
Hilfe von Kreisdiagrammen zu visualisieren. Die Kreisdiagramme sollen in den Stadtteilen mit vielen
Studierenden gréflier dargestellt werden als in jenen Stadtteilen, in denen kaum Studierende leben.
Sie kdnnen dafur die Spalte COUNT mit der Anzahl der Studierenden nutzen. Damit die Diagramme
einfacher platziert und frei verschoben werden kénnen, erstellen Sie zunachst aus dem Layer
StaptTEILEN_MIT_WERTEN €inen Punktlayer mit den Polygonmitttelpunkten (Polygonschwerpunkte).
Meniaufruf: VekTor > GEOMETRIEWERKZEUGE > POLYGONSCHWERPUNKTTE.

Nennen Sie den neuen Layer stadtteilpunkte_mit_werten

x Der resultierende Layer enthalt die gleichen Attribute wie der Ausgangslayer.

x Schalten Sie diesen Layer Bearseirar und verschieben Sie die Punkte gegebenenfalls so,
dass die Kreisdiagramme maoglichst gut platziert werden
(Menutaufruf: Bearseiten > OBJekTE VERSCHIEBEN und dann mit der Maus verschieben)

x Speichern Sie den Layer. LAYER > BEARBEITUNGSSTATUS UMSCHALTEN

Nun kénnen Sie Kreisdiagramme erstellen: xxs *
« Stil
x Wabhlen Sie im Inhaltsverzeichnis den | = Zexneen pagammiys & Kucnendegranm -

Layer stadtteilpunkte_mit_werten aus | aeen et roce WEim Cptnen

Feste GroBe  30,00000
o) Verknupfungen

und rufen Sie den EIGENSCHAFTENDIALOG  [Srrtl  croseneimen  Kerneimneten -
auf (LAYER > EIGENSCHAFTEN) © vatagaten

Linear zwischen 0 und dem folgenden Attribut- / der Diagrammgrifie skalieren:

e w~ T €. Maximawertsuchen 81  GroBe 1150 7 MaBstab Flache ~

x Wechseln Sie zum Bereich DiacRAMME * Kielne Disgramme vergrofiem

und kreuzen Sie DIAGRAMME ANZEIGEN an. e EXAS
T T —

x Geben Sie als Diagrammtyp g P |
»KUCHENDIAGRAMM® @n und fligen Sie die ey Hkea 0000
ATTRIBUTSPALTEN mit den nach EEEE ; s I—
Verkehrsmittelwahl summierten Boeet
Teilnehmer/innen der ATTRIBUTLISTE ZU: Abb. 13: Kreisdiagramme erstellen

SUM_Au, SUM_Oe, SUM_Ra, SUM_Fu (Sie kénnen die Arrrisute im linken Feld mit der
Maus auswahlen und mit pem ,GrRUNEN Kreuz* hinzufuigen)

x  Mit einem Doppelklick auf die Farben kommen Sie in die Farbauswahl, um die Farbgebung
anzupassen. Sie sollten die gleichen Farben wahlen, wie im Kreisdiagramm aus dem
Tabellendokument ,,Verkehrsmittelwahl“ welches sich in der Auswertungstabelle befindet.

1
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x Folgende Parameter filhren zu einer sinnvollen Darstellung:
GroBe: In KARTENEINHEITEN , KEINE FESTE GROsse, sondern nach dem Attribut ,COUNT" skaLIEREN,
Grosse ca.800 - 1000, MaximaLwerT sucHeN klicken, MasssTtas = FLAcHE, MINIMALWERT 99.
PLarzierung: UBer PunkT.

x  Sie kénnen die Skalierung auch tber einen Ausbruck steuern und erreichen mit dem am
Absatzende gelisteten Ausdruck, dass mindestens 4 Teilnehmer/innen fur eine Darstellung
des Kreisdiagramms notwendig sind. Es werden keine Diagramme in Stadtteilen mit weniger
als 4 Teilnehmer/innen angezeigt, wenn Sie diesen Ausdruck (diese Bedingung) nutzen:
Case -

When "COUNT" > 3 then "COUNT" E..
End

Mit AppLy bzw. Anwenpen kOnnen Sie lhre Kreisdiagramme visualisieren. Sie sehen die Verteilung der
Verkehrsmittelwahl in den Stadtteilen. Die Grofe der Diagramme ist entsprechend der Werte in der
Spalte COUNT skaliert. Wenn Sie die Position der einzelnen Diagramme mit der Maus korrigieren
wollen, gehen Sie wie folgt vor:

x Schalten Sie den Layer bearbeitbar: LAYER > BEARBEITUNGSSTATUS UMSCHALTEN.
¥ Rufen Sie Bearsemen > OBJexTE VERscHIEBEN auf und verschieben die Diagramme mit der Maus.
x Schalten Sie den Bearbeitungsstatus wieder zurlck.

Kerneldichte / Heatmap

Die Einfarbung der Stadtteile entsprechend zur Anzahl der Studierenden, stellt die Verteilung auf
administrative Einheiten dar. Diese Methode wird sehr haufig verwendet, um soziale, politische oder
Okonomische Parameter in Karten zu visualisieren. Diese Vorgehensweise gibt die tatsachliche
Verteilung der Werte im Raum nur annahernd wieder, weil die Verteilung innerhalb der
administrativen Einheiten nicht bertcksichtigt wird. In unserem Beispiel wird der ganze Stadtteil
»Nordstadt‘ dunkel gezeichnet, weil hier mit Abstand die meisten Studierenden wohnen. Tatsachlich
konzentrieren sich die Studierenden auf bestimmte Bereiche des Stadtteils. Wenn wir die wirkliche
Verteilung der Wohnorte in der Stadt visuell eindrticklich darstellen méchten, gibt es eine weitere
interessante Moglichkeit. Mit Hilfe von KerNELDICHTEDARSTELLUNGEN, auch Heatmaps genannt, kdnnen Sie
eine kontinuierliche farbige Rasteroberflache erzeugen, welche die tatsachliche Dichteverteilung im
Raum darstellt.

Eingabepunktlayer Verkehrsmittelwahl der Erstsemester -
x Aktivieren Sie unter ERWEITERUNGEN >

ERWEITERUNGEN VERWALTEN die Heatmap-
Erweiterung.

Ausgaberaster laas_daten/2014/heatmap/heatmap1.tif

Ausgabeformat GeoTIFF A

i U Radi 500 Met .
x  Mit dem Menuaufruf Raster > Heatmap > adius eter

Heatmap kommen Sie in den Dialog zum
Erzeugen des Kerneldichte-Rasters.

X Erzeugte Datei zu Karte hinzufligen

w X Erweitert

x  EiNeaBEPUNKTLAYER ist der Ursprungslayer mit Zeten o = Spaiten 1220 -
den Wohnortpunkten.. Zellengréfie X 10 Zellengréfte Y 10
. — Kemfi Dreieck ~
x  Das AuscaserasTer schreiben Sie in den Ordner | " -
meine_Daten und nennen es KERNELDICHTE.TIF. Feld fir Radlus ZJ | Meter ’
. . . Feld fir Gewichtung -
x  Zevensrerme: fur x und y jeweils, 10 = Coratrat —
. . alirate .
Pixelgréfte 10m
. . . Ausgabewerte Rohwerte -
x Als Kernform wahlen Sie Dreieck, als Rabius =
tragen Sie 500 und als VerraLLRATE O ein. Abb. 14: Heatmap-Dialog
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x Normalerweise sollte das Werkzeug mit diesen Parametern ein Raster mit folgenden
Eigenschaften ausgeben:

Ein Pixel des neuen Rasters bekommt genau auf der Position eines Wohnortpunktes den Wert 1. Der
Wert verringert sich fiir die Pixel in der Umgebung des Punktes linear bis zur Entfernung von 500 m
auf 0 (Kernform Dreieck ergibt lineare Abnahme). Liegt ein Pixel im 500 m-Einzugs-Bereich mehrerer
Punkte, werden die resultierenden Werte addiert. Der Pixelwert wird um so hdher, je mehr Punkte
sich in seiner Nahe befinden. Befinden sich 8 Punkte genau in 200 m Entfernung eines Pixels, ergibt
sich ein Wert von 0,5 (halbe Strecke) * 8 also 4.

Leider fuhrt das Werkzeug in der QGIS 2.4 eine Skalierung bezogen auf die Pixelgréf3e durch und
lasst sich nicht wie bei QGIS 2.6 auf Rohdatenabbildung umschalten. Dabei bekommt der
Kreismittelpunkt, wenn sich nur ein Pixel im Einflussbereich des resultierenden Kreises befindet, statt
1 den Wert: (PixerLAcHE /| KREISFLACHE) * 3

Die Pixelflache betragt bei 10m- Auflésung 100 m?, die Kreisflache umfasst bei 500 m Radius
785398 m? (500% x Pi) In QGIS 2.6 kann man zwischen Rohwerten und pixelskalierten Werten
wahlen. Im QGIS 2.4 miussen Sie das Raster umrechnen.:

Wenn sich der Wert eines Heatmap-Pixels in der Keismitte eines Punktes aus (PixerLAcHE /
KreisrLicHE) * 3 ergibt, dann I&sst sich in unserem Fall (10m Pixelaufldésung / 500m Radius) der
Pixelwert mit folgender Formel darstellen

x Pixelwert = (10 * 10 / ( 5002 * Pi)) *3

x  Damit der Pixelwert im Zentrum eines Kreises, auf den nur ein Wohnort wirkt, genau 1
betragt, wenden Sie die Formel: (PixeLwert * 500% * P1) /300 an

Umrechnen!

Mit dem Werkzeug ,RasTerRrRecHNER“kONNEN Sie das Raster mit dieser Formel in die Rohform
umrechnen:

x Menilaufruf: RASTER > RASTERRECHNER

Der PixeLwerT resultiert aus der Heatmap, die im Rasterrechner als RasterkanaL "kerneldichte@1"
ausgewiesen ist und Pi ist bekannterwiese 3,141...

x Also lautet die Formel:
("kerneldichte@1" * ( (500 *500) * 3.141592654)) / 300

Klicken Sie auf aktuelle Layerausdehnung

x Wahlen Sie mit der Schaltflache rechts-oben | rasterkanae T A
den Ort fir die resultierende Rasterdatei und Ausgabelayer AR L A
vergeben Sie einen Namen (KerRNELDICHTET.TIF e
im Ordner pDATEN_AUFGABE_2/MEINE_DATEN) X (soETosATer 3 Xeex (S5O MTET |3
Y-Min 5681728,40225 + Y-Max 5690858,40225 -
ERrGEBNIS ZuM PROJEKT HINZUFUGEN ankreuzen. Spalten | 1220 * Zeien 913 :
x Klicken Sie O.K: Das Raster wird erstellt und i?gt’?m‘mmmmjnﬁ ’
geladen. + opemoren
x Daich schon eine Darstellungsvorschrift . . — an . o ;
geschrieben habe, wird es gleich farbig ) 7 cos = e )
dargestellt: Wenn nicht, gehen Sie in die = S = NG oDER
LAYEREIGENSCHAFTEN und laden Uber die Aactorrechnoraedrac
SchaltﬂaChe ST“— LADEN dle ("Heatmap@1" * ( (500 *500) * 3.141592654)) / 300
Darstellungsvorschrift kerRNELDICHTET.QMmL aus
dem Ordner meine_daten. Abb. 15: Rasterrechner
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Jetzt sehen Sie ein sehr klares Verteilungsmuster. Man kénnte das Gleiche auch noch fir
Teilmengen der Punkte, also z.B. nur fir die OPNV-Nutzer durchfiinren. Wir wollen jedoch in einem
letzten Auswertungsschritt aus dem Raster ein SnvaperiLE der Zonen mit der héchsten
Studierendendichte erzeugen. Dazu missen wir die hohen Pixelwerte auswahlen und in ein neues
Raster mit einer geringen Wertspreizung schreiben, welches wir dann in ein Shapefile konvertieren.

Erzeugen eines Zonenshapefiles

Zunachst reduzieren Sie die Wertemenge, also die Anzahl unterschiedlicher Pixelwerte des
Kerneldichte-Rasters mit dem RasTerRrRecHNER. Ziel ist es, Schwerpunktraume des studentischen
Wohnens festzustellen. Wenn Sie samtliche Pixel auswahlen, die im Kerneldichteraster (der
Heatmap) Uber einen Wert von mindestens 4.5 verflgen, bleibt eine solche Kernflache tbrig

x Menuaufruf: Raster > RASTERRECHNER

x  Mit einem Doppelklick aufden unter RasterkanaL kerneldichte1@1 wahlen Sie lhr
umgerechnetes Kernel-Dichteraster aus.

x Klicken Sie einmal auf ,AkTueLLe LaverauspeHNUNG®, um die Ausdehnung des zu berechnenden
Rasters auf das Dichteraster zu beschréanken.

x Den AuscrBELAYER speichern Sie im Verzeichnis meine_Daten und nennen es zonen.tif
x  Der RasterrecHNERAUSDRUCK ist: kerneldichte1@1 >= 4.5

x Bedeutung: Im Raster zonen.TiF bekommt jeder Pixel, der im Dichteraster einen Wert von
mindestens 4,5 hatte, den Wert 1 fir ,Bedingung trifft zu“ - Sdmtlichen anderen Pixeln wird
der Wert 0 zugewiesen.

X  ErceEBNis zum PRroJeEKT HINZUFUGEN ankreuzen und O.K
Jetzt konnen Sie ein Shapefile mit den Zonen erzeugen.
x Prifen Sie unter ERWEITERUNGEN > ERWEITERUNGEN VERWALTEN, Ob die GDAL-Tools aktiviert sind.

x  Mit dem Menuaufruf Raster > KoNvERTIERUNG > VEKTORISIEREN Kommen Sie in den Dialog zum
Erzeugen eines Shapefiles aus dem Raster.

EiNcABEDATEI (RASTER): ZOnen

AuscaBepaTEl: Sie wahlen einen Ordner und bestimmen einen Namen.
FeLoname: Ankreuzen, DN als Bezeichnung lassen, Maske: ignorieren
NacH AsscHLUss DER KARTE HINZUFUGEN: ankreuzen dann O.K

X X X X X

Den resultierenden Shapefile-Layer anschlieliend bearbeitbar schalten und nach Menuaufruf
AnsicHT > AuswaHL > NAcH AusDRuck WAHLEN Uber die Abfrage "DN" = 0 alle Bereiche wahlen,
die nur eine geringe Dichte aufweisen. Mit dem Menutaufruf BEARBEITEN > AUSGEWAHLTES LOSCHEN
I6schen sie diese Bereiche und kénnen den Layer anschlie®end Uber Laver >
BEARBEITUNGSSTATUS UMSCHALTEN Speichern.

Wenn Sie jetzt die Werte aus dem Punktshapefile rdumlich Ubertragen, kdnnen Sie eine klare Zu-
FuR-Zone und eine klare OPNV-Zone abgrenzen.

Daten auf Zonenshapefile libertragen / Zonenshapefile symbolisieren

Jetzt sollen Sie die Werte aus Ihrem PunktsHaperiLe auf die neue ZoniErung Ubertragen. In der fertigen
Karte sind die Zonen nach bevorzugter Verkehrsmittelwahl einzufarben.

Mit dem MenUaufruf Vektor > DATENMANGEMENTWERKZEUG > ATTRIBUTE NACH POSTION ZUSAMMENFUHREN
Ubertragen wir die Daten des PunkTtLavers summiert auf die Zonen:
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ZieLvekToRLAYER: Das aus der Vektorisierung der Kerneldichte entstandene Shapefile

X Aus VekTorLAYER: Das Punkt-Shapefile (aLLe_waHren_wonnorTE 0der wenn Sie den Namen
geandert haben VERKEHRSMITTELWAHL DER ERSTSEMESTER).

X ATTRIBUTZUSAMENFASSUNG: ,Zusammenfassung der schneidenden Objekte erstellen, dabei
ankreuzen: SumME.

X AuscasesHaPeDATEI: Ort auswahlen und mit einem Namen lhrer Wahl benennen.

X ALLE DATENSATZE ERHALTEN.

Im resultierenden neuen Polygon-Shapefile sind samtliche Spalten zu I6schen, mit Ausnahme der
vier SUMverkehrsmittel_* Spalten (Summe der Studierenden bezogen aufs Verkehrsmittel) und
COUNT (Anzahl der Studierenden:

x Spalten Loschen: Layer BEARBEITBAR sCHALTEN, dann in der Attributtabelle auf die Schaltflache
neben dem Feldrechner klicken, um eine Liste der Spalten anzuzeigen, die Sie per Mausklick
zum L&schen auswahlen kénnen. AnschlieRend geandertes Shapefile speichern.

x Oder: TasLEMANAGER verwenden: Shapefile im Inhaltsverzeichnis auswahlen und Tablemanager
mit dem MenUaufruf Vektor > TaBLEMANGER > TaBLRMANAGET 6ffnen, die Uberflliissigen Spalten
mitt der Maus auswahlen und I6schen!

x  Mit der Save-Schaltflache den geadnderten Layer speichern

AnschlieBend berechnen Sie die Stupierenben Je akm und die OPNV-Quotk. In der Spalte COUNT
finden Sie die Anzahl der Studierenden in den jeweiligen Zonen, in den SUM_-Spalten finden Sie die
Anzahl der Studierenden, aufgeschlisselt nach Verkehrsmittelwahl.

Eine Spalte fur die OPNV-Quote kénnen Sie mit dem FeLbrecHNER anlegen.
x  Neues Feo mit Namen oequ anlegen im GanzzaHL-Format

x  Den prozentualen Anteil der OEPNV-Nutzer (SUM_Oe) an allen Studierenden (COUNT)
errechnen Sie mit; "SUM_Oe" / "COUNT" * 100

x In gleicher Weise kénnen Sie auch den Anteil der anderen Verkehrsmittel fir die Zonen
ermitteln.

Anschlieend symbolisieren Sie den neuen Layer in einem abgestuften Stil anhand des neu
erstellten Attributs oequ in zwei Klassen im Modus ,NaturLIcHE UNTERBRECHUNGEN". Beschriften Sie die
Klassen mit FusscANGer > 80 % und OEPNV > 80 %.

Auf der nachsten Seite sehen Sie, wie sich das Zonenshapefile fur eine eindrickliche Karte nutzen
I&sst (Beispiel: Abb. 1, S. 2). Im Kartenbeispiel ist die Verteilung der Verkehrsmittelwahl zusatzlich
uber Kreisdiagramme dargestellt. Das mussen Sie ausdrucklich nicht, durfen Sie jedoch gerne. Auch
die Entfernungslinien sind nicht Teil Ihrer Aufgabe. Dazu werde ich einiges in der Vorlesung sagen.

Welche Karten Sie jetzt aus Ihren aufbereiteten Daten gestalten und abgeben missen, erfahren Sie
auf den letzten Seiten dieses Skriptes.
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Studierende, Wohnorte und Verkehrsmittelwahl
Schwerpunktraume aus Kerneldichteanalyse mit Verkehrsmittelwahl
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Abb. 16: Karte mit Schwerpunktrdumen aus den Zonenshapefiles mit Kkreisdiagrammen
(Karte enthalt verschiedene Elemente, die Sie in Ihrer Abgabe nicht umsetzen mussen,
orientieren Sie sich bei Ihrer Karte an Abb. 2 auf S. 2)

Karten Layout

Jetzt haben Sie die Geodaten so visualisiert, dass Sie die Wohnorte und die Verkehrsmittelwahl! der
Kursteilnehmer/innen in eine aussagekraftige Karten umsetzen kénnen! Das Karten-Layout erzeugen
Sie in einem eigenen Programmfenster, der DruckzusaMMENSTELLUNG, die Sie Uber

Datel > Neue DruckzusammeNnsTELLUNG erreichen. Auf S. 89 bis S. 114 des Folienskripts 1B werden
die Funktionen zum Karten-Layout und zur Druckausgabe detailliert erklart!

Sie mussen zwei Karten-Layouts erzeugen. In Karte 1 werden die nach Studierendenanzahl
klassifizierten Stadtteile mit den Kreisdiagrammen dargestellt. Zusatzlich soll das in der
Tabellenkalkulation erstellte Kreisdiagramm mit der Verkehrsmittelwahl aller Kursteilnehmer/innen als
Bild in die Karten eingefiigt werden. Karte 2 beinhaltet das Zonen-Shapefile und den Punktdaten-
Layer mit den nach Verkehrsmittelwahl visualisierten Wohnorten. Jede Karte muss neben dem
eigentlichen KartensiLD (KarRTENFELD), samtliche fiir eine Karte unentbehrlichen Elemente enthalten:
BescHRIFTUNGEN (Kartentitel, Kartenautor, Erstellungsdatum) Lecenoe und MassstassBALKEN. Achten Sie
darauf, dass das Kartenbild das bestimmende Element der Karte ist! Wahlen Sie als
Papierausrichtung Querformat!

Schauen Sie sich das Layout der Beispielkarten auf Seite 2 an.
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Die erste Karte

X

*X X X X%

Fir die erste Karte (siehe: Abb. 1, S. 2) lassen Sie nur die Layer stadtteile_mit_werten (aLso
DIE NACH STUDIERENDENZAHL KLASSIFIZIERTEN STADTTEILE MIT DEN KREISDIAGRAMMEN) und den Unipunkt in
der Kartenansicht aktiviert. Die anderen Layer blenden Sie aus, in dem Sie die Kreuze im
Inhaltsverzeichnis per Klick entfernen.

Laden Sie die Layout-Ansicht liber den Meniiaufruf ProJekt > Neue DRUCKZUSAMMENSTELLUNG
Stellen Sie im Reiter ZusammensTeLLunG die Orientierung auf Quer und die Seitengrofie auf A 4.
Mit dem MenUaufruf AnsicHt > VoLLE AuspeHNuNG” zeigen Sie die Seite in voller GroRe.

Klicken Sie auf das Icon zum ,KarTEN HINZUFUGEN® (oder MenUaufruf ANORDNUNG > KARTE EINFUGEN)
und ziehen Sie mit der Maus ein Rechteck auf. Das Kartenfenster sollte in der Breite ca. 3/4
des Blattes einnehmen. Sie bendtigen jedoch auch noch Platz fiir Legende etc.

Kassel sollte das Kartenfenster moglichst umfassend ausftllen. Mit der Maus, nach dem
Menuaufruf ANorRDNUNG > INHALT VERscHIEBEN und verschiedene Einstellungsmadglichkeiten im
ELemenTEIGENSCHAFTEN-REITER Sollte Ihnen das gelingen (Siehe Folienskript)!

Als nachstes rufen Sie ANorRDNUNG > LEGENDE HINZUFUGEN auf und platzieren die neue Legende
mit der Maus.

Im Reirer ELEMENTEIGENSCHAFTEN gibt es umfangreiche Mdglichkeiten, um die Legende zu
gestalten. Sie kdnnen Elemente verschieben, |6schen und umbenennen (Siehe Abb. 17)

Sie kénnen Schrift und Schriftstil jeweils fir den LecenpenTiTEL, flr GrRuPPEN UNnd UNTERGRUPPEN
(Layertiberschriften kénnen Gruppen oder Untergruppen zugewiesen werden) sowie flr die
einzelnen ELemenTe individuell auswahlen. Auch Abstande und Zwischenrdume kdnnen Sie
individuelle bestimmten.

Sie kénnen die einzelnen Elemente der Legende I6schen und nach oben oder nach unter
verschieben.(Pfeil-Symbole, - fiir I6schen + fir hinzufligen)

Sie kénnen den Text fur jedes Element andern oder 16schen, in dem Sie das Element mit der
Maus auswahlen und auf Anpern (Schaltfléche ,Stift“) klicken. Danach kénnen Sie den Text
bearbeiten oder I6schen.

Probieren Sie ein wenig herum Es gibt eine ,Rickgangig-Funktion“!: BEArRBEITEN > RUCKGANGIG
Speichern Sie |hr Projekt zwischendurch. ZusaAMMENSTELLUNG > PROJEKT SPEICHERN!

Leagende anklicken dann kénnen Sie Einzelne Elemente mit dem Inhaltsverzeichnis P
g synchronisieren (Nach Anderungen der Anderungen aus der

im Reiter Eintrag > Legendenelemente Symbolisierung) Anordnung und Ansicht
Legendenelemente I6schen, umbenennen Beschriftung aus Inhaltsverzeichnis (Symboli;_sierung
und in der Anordnung verschieben | erdenlbemomment! etc.) mussen
; - N / aktualisiert werden
Bearbeitbare Auflistung aller Legendenelemente. | [ -
Zunichst so geschrieben und angeordnet Lege"d}’“e'e"‘f“‘e /,JBB_SChﬂﬂung und Anordnung
wie im Inhaltsverzeichnis der Ansicht. [ Eloment atuaikeren | [ Alle aktua I‘:’{:"’ mit dimn!:"hhrzms:gz;'Ch“'s
Beschriftung aus Layer > Eigenschaften > Stil < Beschr. (Alle Xndemngen gehen
bzw. Layer > Eigenschaften > Stil > Label (bei regelbasiert) 1 2 verloren!!!t!
Jedes Element ist auswahlbar und bearbeitbar!

LIRS ECTEM W CUI Untergruppe Sl

COUNT™, Gruppe _ — " Layerbezeichnun
- - keine ™ grupp —+— verstecken oder als
Wenn méglich sollten Sie die [ Eivenschaften des1 = KIE3] 5 ™ N - N
<5 N, | Versteckt Zwischenuberschrift
Benennung und Anordnung der P e | 5-12 4

Elemente in der Ansicht (Layer > Crae] e | [T 12-26 mit der Maus nutzen
—
o

Eigenschaften > Stil) bearbeiten, : iy . anwahlen

da beim Aktualisieren der Legencde  Dialog zum Bearbeiten des —

im Layout immer wieder darauf Elementtextes Stadtteile Verbteckt “
zurlickgegriffen wird, teile_mi.. 5

Ilmlﬂrnmnnn
Gewdhltes Legendenelement nach oben L J_? & [ .-:&”\
oder nach unten verschieben Aummauékh it ‘SIMN — 1 Dialog zum Bearbeiten des
- i Elementtextes éffnen

\

\ \\\‘: \\ y

Kreuzchen herausnehmen,wenn einzelne Layer oder ~
Elemente aus der Legende geléscht wurdenund nicht| | Gewadhites
automatisch wieder eingesetzt werden sollen stchenuberschrlft endenelement loschen

Bei mehreren Druck- Layouts wichtig! (Gruppe hinzufiigen)

‘ Neuen Layer aus der Ansicht iibernehmen

Abb. 17: Legende im QGIS-Drucklayout bearbeiten
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x Als nachstes fugen Sie ein TexTeLemenT als Kartenuberschrift ein:
ANORDNUNG > BEscHRIFTUNG HINZUFUGEN und dann mit der Maus platzieren. Sie kdnnen den
Rahmen verschieben und vergréRern, die Rahmenbegrenzung ausblenden und verandern
sowie SchriftgroRe, Schriftstil und Schriftart verandern. Fligen Sie auch Ihren Namen und das
Datum als Beschriftung ein.

x Fugen Sie Uber ANorDNUNG > MasssTas HINZUFUGEN einen Mal3stabsbalken ein. Nachdem Sie
den Mal3stabsbalken platziert haben, kénnen Sie im Reiter ELEMENTEIGENSCHAFTEN umfangreiche
Einstellungen vornehmen. Um eine Darstellung mit der Einheit km zu bekommen, wahlen Sie
als KARTENEINHEITEN PRO MasssTaBseINHEIT 1000 (eine KarTENEINHEIT ist ein Meter) und als
SecemeNTGROssE ebenfalls 1000. Wenn Sie als AnzaHL bEr SEGMENTE REcHTs 3 wahlen und als
Beschriftungseinheit ,km* eintragen, bekommen Sie einen Mal3stabsbalken mit 3 Segmenten
zu je 1 km.Sie kdnnen den Darstellungsstil und die Beschriftung nach Ihrem Geschmack
anpassen.

Einfligen des Diagramms aus der Flachenbilanz-Tabelle.

x Als letztes mussen Sie die Diagramme ,Verkehrsmittelwahl in %" und ,Verkehrsmittelwahl
nach Entfernung” aus der von lhnen ausgeflillten Tabelle fldchenbilanzen in das Kartenlayout
einzufiigen, um mit diesem Diagramm die stadtteilbezogenen Kreisdiagramme zu erlautern.

x Dazu missen Sie die Diagramme in ein Grafikformat umwandeln. Sie kdnnen es aus der
Tabellenkalkulation ins PNG-Format speichern: Mit RECHTER MAUSTASTE ANKLICKEN > ALS GRAFIK
EXPORTIEREN: als *.png speichern!.

x Diese Bildatei kdnnen Sie Gber AnorbNuNG >BiLb HiNzurFUGeN einfligen. Klicken Sie mit der Maus
auf die gewlinschte Position und wahlen Sie dann lhre Datei aus, in dem Sie unter dem
Reiter ,EINTRAG" die ,BiLbaueLLE” Uber die zugehdrige Schaltflache auswahlen.

Export als PDF-Karte

x Jetzt konnen Sie die Karte Uber Datel > aLs PDF exporTIEREN in eine PDF-Datei speichern
Dateinamensmuster: vorname_nachname_aufgabe2_karte1.pdf

Die zweite Karte

In einem zweiten Layout sollen Sie die Wohnorte der Studierenden als Punkte Uber dem
klassifizierten Zonenshapefiles visualisieren (Siehe Beispielkarte Abb. 2. auf S. 2). Zu diesem Zweck
Sie eine zweite DruckzusammensTELLUNG. Vorher fixieren Sie die Darstellung im ersten Layout, in dem
Sie auf das Kartenfenster im Layout klicken und dann im Reiter ,, ELEMENTEIGENSCHAFTEN >
HaurTEIGENSCHAFTEN® das Kreuz bei ,LAYER DEs KARTENELEMENTS FESTHALTEN" setzen. Anschlief3end bleibt
die Darstellung so erhalten, auch wenn Sie die dargestellten Layer in der Ansicht ausblenden. Sie
koénnen die Anordnung der Elemente in Ihrem Layout anschliefend als Vorlage speichern (Im Layout:
ZUSAMMENSTELLUNG > ALs VORLAGE sPEICHERN). Diese Vorlage kdnnen Sie dann in der neuen
Druckzusammenstellung als Ausgangspunkt nutzen.

x Verlassen Sie nun die DruckzusammensTELLUNG und wechseln Sie in die normale Ansicht. Dort
deaktivieren Sie den Stadtteillayer und setzen das PunkTsHAPEFILE, das ZONENSHAPEFILE (MUSS
naturlich unter dem Punktshapefile liegen) und unterhalb noch das StrassenneTz und den
STADTTEILGRENZEN-BAsISLAYER zur Orientierung aktiv.

x  Speichern Sie das Projekt und 6ffnen Sie eine neue Druckzusammenstellung. Dort kdnnen
Sie lhre Vorlage aus der ersten Druckzusammenstellung Uber ZusAMMENSTELLUNG > ELEMENTE Aus
VORLAGE HINZUFUGEN als Ausgangspunkt verwenden. Sie mussen dann naturlich im neuen
Layout die Funktion ,LAver bEs KARTENELEMENTS FESTHALTEN® deaktivieren, damit Sie das Layout
mit den in der Ansicht geladenen Layern aktualisieren kdnnen.
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x Nun konnen Sie die zweite Karte so wie in Abb. 2. auf S. 2 dargestellt layouten und als PDF-
Datei exportieren. Dateinamensmuster: vorname_nachname_aufgabe2_karte2.pdf

Abgabe der Ergebnisse

Geben Sie die beiden PDF-Karten vorname_nachname_aufgabe2_karte1.pdf und
vorname_nachname_aufgabe2_karte2.pdf auf der Moodleseite ab. Bitte geben Sie zwei einzelne
Dateien und kein Zip-Archiv ab!

Halten Sie sich genau an die NamensVorgaben!!

Abgabe bis zum 16. Dezember um 20 Uhr Giber Moodle ab!

Bei groRBeren Problemen: Tutorium im clab am 05.12.

Viel Erfolg!
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